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“Life happens on the edges. We can’t find the next place on our journey 

until we discover the edge between the place we are and the place we need 

to go. Something ends and something else can begin only along an edge. 

Along edges we find and feel the penetrating and incisive qualities that give 

definition to our life. Our interface with life is sharpened at the edge. We 

discover our greatest zest and our most keen desires at the edge. “ 

 

- Pilgrim Wheels: Reflections of a Cyclist Crossing America 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Read the HBR Article citing until you have the SKILLS productivity tools are useless. 

https://hbr.org/2016/08/until-you-have-productivity-skills-productivity-tools-are-useless
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The Cycle of Performance 
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[Outlook 2010/2013/2016] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the 
File tab.

Click on 
Options.

Click on the 
Mail option.

Under 
Message 

Arrival 
section, 

uncheck all 4 
boxes.

Click OK to 
close.

1. View the Calendar. 

 

2. Click on the HOME tab. Select the Week View Icon. 

 

3. Click the VIEW tab. Click the TO-DO BAR button and check NORMAL. Uncheck APPOINT -  

MENTS and uncheck QUICK CONTACTS (if showing).  

 

4. Click the DAILY TASK LIST button and select Normal. 

 

5. Place the cursor between the Calendar and To-Do Bar so that the mouse pointer turns into 

bi-directional arrows, and drag the To-Do Bar panel to the left to adjust to desired width. 

 

6. In the To-Do Bar panel, right click on the word TASK SUBJECT, or on the words CLICK HERE TO 

ADD NEW TASK. Select VIEW SETTINGS from the menu. This will open an advanced view 

settings dialog box. 

 

7. Click the COLUMNS button to change the default column headings: 
a. Highlight all the columns in the SHOW THESE COLUMNS IN THIS ORDER list box and click the 

REMOVE button. 

b. Change the SELECT AVAILABLE COLUMNS FROM to FREQUENTLY USED FIELDS. (Scroll to the 

top of the list to access). 

c. From the AVAILABLE COLUMNS list box, select the following: ATTACHMENT, COMPLETE, ICON, 

PRIORITY, SUBJECT, and DUE DATE by clicking on each one and then clicking on the ADD 

button. 

d. Click OK to close the FIELDS dialog box. 

 

Read the Telegraph article 

citing study about email 

notifications causing anxiety. 
 

http://www.telegraph.co.uk/news/2016/03/22/psychologists-warn-constant-email-notifications-are-toxic-source/
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Press CTRL + 
SHIFT + K or 

double-click in 
the Task List in 
the space that 
says ‘Click to 

Add a New Task’.

Fill in the 
Subject box.

Set a Due Date 
for the Task, if 
the task meets 
the criteria for 
having a due 

date.

Click Save and 
Close to save 

your changes to 
the Task.

8. Click the GROUP BY button to show the list, categorized: 

a. Uncheck AUTOMATICALLY GROUP ACCORDING TO ARRANGEMENT. 

b. From the Group Items By dropdown menu, select Categories. 

c. Under Expand/Collapse Defaults in the lower right, select All Collapsed. 

d. Click OK to close the GROUP BY dialog box. 

 

9. Click the FILTER button to remove flagged items: 

a. Click the Advanced tab. 

b. Highlight the Flag Completed Date option and click REMOVE. 

c. Click the FIELD button, select ALL MAIL FIELDS, FLAG STATUS, from the drop down menu. 

d. Click the ADD TO LIST button then click OK to save and close the FILTER dialog box. 

 

10. Click the OTHER SETTINGS button to get flexibility in column sizing: 

a. Uncheck the top right box AUTOMATIC COLUMN SIZING and press OK. 

b. Under Other Options uncheck Always Use Compact Layout – make sure Single Line 

Layout Radial is checked. 

 

Read the Fast Company Article on workplace predictions for the next 20 years 

Working internationally? 

Add a second-time zone 

by right clicking on the 

time zone to the left of 

your calendar 
 

https://www.fastcompany.com/3052872/twenty-predictions-for-the-next-20-years?utm_source=mailchimp&utm_medium=email&utm_campaign=fast-company-daily-newsletter&position=1&partner=newsletter&campaign_date=11232015
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Mind Sweep Trigger List 

Meetings that need to be 

set/requested 

Who needs to know about what 

decisions? 

Legal, real estate, zoning, taxes 

Projects started, not completed Significant read/review Builders/Contractors/Suppliers 

Projects that need to be started Travel Areas to organize/clean out 

Commitments/promises to 

others 

Research – need to find out 

about… 

Financial 

Communictions to make/get Upcoming events Vehicle repair/maintenance 

Initiate or respond to: 

Phone calls 

Emails 

Letters/Memo 

Administration 

Legal issues 

Insurance 

Personnel 

Policies/procedures 

Waiting for… 

Information 

Delegated tasks/projects 

Completions critical to projects 

Reimbursments 

Other writing to finish/submit 

 Reports 

 Evaluations/reviews 

 Proposals 

 Articles 

 Promotional Materials 

Manuals/Instructions 

 Re-writes and edits 

 

Systems 

 Phones 

 Computers 

 Utilities 

 Filing 

 Storage 

 Inventories 

 Supplies 

Customers 

 Internal 

 External 

 Marketing 

 Promotion 

 Sales 

 Customer Service 

 

 

Research on the benefits of mindfulness is explosive.  See Article on what science is 

teaching us about the benefits of mindfulness practices. 

Download your free Mind-Sweep trigger list here. 

 

http://www.mindful.org/research-roundup/
http://effectiveedge.com/alumni/
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Recommended Categories 

Planning Managing Actions 

.Project Plans – Business 

.Project Plans – Personal 

1:1 _____________ 

(e.g. boss, directs, family) 

 

1:1 Team 

(e.g. Sales Team, Staff Meeting, 

Project Team etc.) 

Actions 

Calls 

Emails 

Errands 

Home 

Read/Review 

Someday Maybe  

Waiting For 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

   

 

  

  

  

 

   

 

To Set Up New Categories: 

1. Press CTRL + Shift + K to create a new task. 

2. Click the Categorize button on the Task tab and 

select the All Categories option. 

3. To add a new category, click the New button. 

Type the name in the Category Name text box. 

If desired, click on the Color drop down-box to 

assign a color to the Category. Choose OK to 

save the Category. 

4. Repeat step 3 for each new Category you wish 

to add. 

 

When all Categories have been entered, uncheck all 

the boxes to the left of the category names and 

click OK to close the Color Category dialog box.  

 

 

To Categorize a Task: 

1. Double-click to open the task. 

2. Click the Categorize button on the Ribbon and 

select the Category from the drop-down list. 

3. If there’s a real due date, assign the task a due 

date. 

4. Click Save and Close to save your changes to 

the Task. 

-OR- 

1. Right-click on the task. 

2. Select the Categorize option from the menu 

and select the Category from the drop-down 

list. 

 

Read more information from 

Fast Company on  

The Cost of Switch-Tasking. 

 

https://www.fastcompany.com/944128/worker-interrupted-cost-task-switching
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The EDGE DECIDING Model 
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1. Write the name of your project in the subject line.  Drop down Categories and Categorize 

under .Project – Business or .Project – Personal. 

 

2. Write the Desired Outcome Statement – A clear statement of what the project will look like 

and feel like when it is accomplished.  

 

3. When planning your project remember to perform a Project Mind Sweep – You can do this 

right in the body of the task or even do a Mind-Map in OneNote and then link to it from here. 

 

4. Insert Hyperlinks to necessary resources: INSERT TAB --- Hyperlink, Attach File or Outlook Item 

 SharePoint  - e.g. Project Plan for sharing with the team. 

 OneNote – e.g. Mind Sweep,  Mind-Map or Project Meeting Notes 

 Documents – e.g. Budget 

 Folders – e.g. Project Folder rather than single document 

 Email – Specifications on your project came in an email.   

 

5. Create a Next Action in a new Task Item and categorize in one of your Action Categories. 

 CTRL+SHIFT+K 

 Make sure your subject line is CLEAR, ACTIONABLE and perhaps even has the project 

name in the subject line to make connecting your Action with your Plan easier. 

 

 

https://www.ted.com/talks/simon_sinek_how_great_leaders_inspire_action
https://www.ted.com/talks/simon_sinek_how_great_leaders_inspire_action


  10 

 

 

 

  

 

 

 

 

 

 

 

 

 

  

Select HOME Tab 

 Drop down Meeting Details from the Ribbon 

 Select the Meeting (Pulls from your Outlook Calendar) that you are keeping notes on. 

 

Create Actions that automatically link to your EDGE System in Outlook 

 Type the Action 

 Click on the Action and Tag as To Do – This will automatically appear on your Outlook 

Task List in the None Category 

 

Find your “Tagged Items” by Selecting HOME tab --- Find Tags. 

 

Mind-Sweep or Mind-Map your initial thoughts around 

your project 

DRAW feature connects related components with color. 

INSERT 

 File to attach a particular document 

 Screen Clipping to insert a great screen shot 

 Online Pictures and Online Videos so the visuals 

are right there 

 Hyperlinks to other websites 

 Audio/Video recordings 

 

 

To Plan a Project in OneNote 
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To View Your Inbox by Conversation 

[OUTLOOK 2010/2013/2016]: 

1. From your mailbox, click on the View tab. 

2. In the Conversations group, checkmark the 

Show As Conversations option. 

3. Click the All Folders option to apply the 

Conversation view to all your mail folders. 

4. Click the down triangle next to the top level 

message in the conversation to view the 

conversation thread. To collapse the 

conversation, click the triangle again. 

 

 
To Ignore a Conversation 

 [OUTLOOK 2010/2013/2016]: 

To Clean Up a Conversation  

[OUTLOOK 2010/2013/2016]: 

1. Click on the Home tab. 

2. In the Delete group, click on the Ignore button. 

The conversation and all of its associated 

messages (previous and future) will be moved 

to the Deleted Items folder menu and select the 

Category from the drop-down list. 

 

1. Highlight your inbox by pressing Ctrl + A. 

2. Click on the Home tab. In the Delete group, 

click on the Clean Up button and choose Clean 

Up Conversation. Any redundant messages 

(messages whose entire content is contained 

in another message) will be moved to the 

Deleted Items folder. 

To Filter your Inbox 

 [OUTLOOK 2010/2013/2016]: 

1. Click on the Filter E-mail button on the Home 

tab.  

2. Select the type of messages you would like to 

view. 

3. Click the Close Search button on the ribbon to 

return to your full mailbox.  

Quick Parts feature saves frequently used templates so there’s no need to re-type them again and again.   

1. Type out a Template that you wish to use (Meeting Request, Project Plan, Report, PASS Model etc….) 

2. Highlight the Template 

3. Select your “Insert” Tab 

4. Drop down Quick Parts 

5. Select “Save Selection to Quick Part Gallery” 

6. Name your Quick Part (ie. Meeting, Project, etc) 

7. Select OK 

8. Use as needed to auto populate 

 

 

http://dilbert.com/search_results?terms=Email
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The PASS Model 

Purpose What is the Purpose of this email? 

Action What is the Action and by when? 

Supporting 

Information 
What Supporting Information do you need? 

Subject Lines Is my Subject Line clear? 

 

  

Communication Protocols 

 Chat/Text Email 
Collab Tool 

(SharePoint) 
Call 

Virtual 

Meeting 

In-Person 

Meeting 

Quick Question X      

Urgent Question/Issue    X   

Sharing Updates  X X    

Sharing Files   X    

Group Decision   X  X X 

Heated/Difficult 

Discussion 
   X  X 

Performance/Feedback      X 

Some companies are eliminating email altogether.  

Read about it in Fast Company, BBC, and HBR. 

And check out this HBR article on how  

bad writing is destroying your company’s productivity 

A Communication Protocol helps teams to know what method of communication is 

appropriate for various types of communication. The chart above is a simple example of 

a team’s decisions around how they will communicate. 

https://www.fastcompany.com/3035927/agendas/inside-the-company-that-got-rid-of-email
http://www.bbc.com/capital/story/20150324-the-companies-that-banned-email
https://hbr.org/2016/06/some-companies-are-banning-email-and-getting-more-done
https://hbr.org/2016/09/bad-writing-is-destroying-your-companys-productivity
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To Create a Quick Step shortcut Defer 

to Task [OUTLOOK 2010/2013/2016]: 

1. From the mailbox, click on the HOME tab. 

2. In the Quick Steps box, click the CREATE NEW 

button. 

3. In the NAME text box, enter Defer to Task. 

4. Click the down arrow next to the Actions 

list and choose CREATE a Task With 

attachment from the menu. 

5. Click the add action button. 

6. Select Delete Message from the menu. 

 

 

To create a Quick Step shortcut Defer 

to Calendar [OUTLOOK 2010/2013/2016]: 

1. From the mailbox, click on the HOME tab. 

2. In the Quick Steps box, click the CREATE NEW 

button. 

3. In the NAME text box, enter Defer to 

Calendar. 

4. Click the down arrow next to the Actions 

list and choose CREATE an Appointment 

With Attachment from the menu. 

5. Click the add action button. 

6. Select Delete Message from the menu. 

 

 

 

https://hbr.org/2014/07/the-cost-of-continuously-checking-email
https://hbr.org/2014/07/the-cost-of-continuously-checking-email


  14 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

Prioritize your Tasks  

Plan your week realistically 

Before you can plan your time effectively, 

you will have to prioritize your Task List.  

Not everything on the Task List will make 

it onto the calendar.   

1. View your Dashboard view 

(Weekly Calendar and Task List). 

2. Expand each Action Category one 

at a time. 

3. Prioritize by adding Due Date or 

Priority value. 

 

 

Now that your Task List is prioritized you can 

calendar the most important items. You know 

the “rhythm” of your day better than anyone, so 

build that rhythm into your calendar. 

1. RIGHT CLICK and DRAG the MOST 

important items from your Task List to 

your calendar to schedule time to 

complete.  OR 

2. Create block of time on your calendar 

to complete critical items on your list. 

3. Leave enough “white space” on your 

calendar to accommodate unforeseen 

events/emergencies etc..  

4. Remember to calendar “prep time” in 

advance of meetings, presentations etc. 

5. Remember to calendar “catch up time” 

following travel or extended absences. 
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Perform a 
Mind 

Sweep.

Review 
Outlook 
Today to 

see what is 
due today 
and what 
meetings 
you have.

Ensure that 
you are 

prepared 
for any 

meetings 
(i.e., 

agendas, 
paperwork, 
directions, 

etc.)

Review 
..Actions 

list for any 
key 

upcoming 
actions 

due.

Set an 
intention 

for the day.

Begin the 
day!

Now that your calendar is planned and your time prioritized…Outlook Today becomes your new default view 

for starting your day and it is a great place to come back to after an unexpected interruption to get re-focused 

on what is most important. 

1. Click on the Mailbox folder, typically your email address found at the top of folder list. 

2. Select CUSTOMIZE OUTLOOK TODAY. 

3. Check the WHEN STARTING, GO DIRECTLY TO OUTLOOK TODAY option. 

4. Change the SHOW THIS NUMBER OF DAYS IN MY CALENDAR option to 1.  

5. Change the IN MY TASK LIST, SHOW ME option to TODAY’S TASKS. 

6. Unselect the INCLUDE TASKS WITH NO DUE DATES option. 

7. Click the SAVE CHANGES command in the top right corner of the screen. 

 

 

To Set Up Outlook Today:  

TED TALK worth viewing:   

Yves Morieux: Six rules to simplify. 
 

https://www.ted.com/talks/yves_morieux_as_work_gets_more_complex_6_rules_to_simplify
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Weekly Recharge – The Secret to Success 

Do a mind-

sweep 

5 mins 

• Ctl Shft K will make your day! 

• Clear your mind by creating a task for each action item that you are carrying 

around in your head.  

Empty & 

organize all 

collecting points 

10 mins 

• Empty all other collecting points and categorize appropriately.  

• Clear the V.I.N.E. (Voice Mail; Inbox; Notebooks; Email).   

• Add action items to your task list. 

• File reference items, and discard everything else. 

Review your 

Calendar 

10 mins 

• Acknowledge completions, reprioritize /re-calendar uncompleted items that 

were not completed, and renegotiate anything that may have fallen through 

the cracks. 

• Capture any new action items in your Task List. 

• Review recurring appointments (e-mail processing, meeting prep, travel, 

exercise, lunch, etc.)  

• Assess how appointments are working for you and adjust as necessary. 

Review your 

Project 

Category 

15 mins 

• What have you completed? 

• What next actions need to be completed in the next five to seven days to 

keep your Projects moving forward? 

• Capture these tasks and categorize or calendar as appropriate. 

Review your 1:1 

Team & 

Manager 

Categories 

5 mins 

• Acknowledge completions. 

• Review, plan and prioritize discussion points for upcoming 1:1 meetings. 

Prioritize & Plan 

Action 

Categories 

10 mins 

• Review and prioritize the items in each of your Categories by expanding and 

reviewing the contents of each category. 

• Acknowledge completions. 

• Establish priorities using either a due date or other form of prioritization, 

and then schedule work time on your calendar to complete all priority items. 

Ask yourself the 

following 

Questions 

5 mins 

• Is my calendar realistic? 

• Am I delegating appropriately? 

• Do the actions and meetings that I’ve scheduled on my calendar support 

completing my priorities? 

• Is my time focused on my priorities? 

• What story is my calendar telling me in terms of my work/life balance? 

Podio created these charts to depict how famous creative people structured their 

days. For many of them a good part of the day is not spent on work! 

https://podio.com/site/creative-routines
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For additional Quick Keys go to keyword: Keyboard Shortcuts in Outlook Help 

 

 

 

There is so much more to share.  We’ve done our homework on the 

science behind WHY Effective EDGE is so effective.  Enjoy these recent 

articles that may help deepen your productivity practices! 

 

Until you have the skills; productivity tools are useless 

Great Companies Obsess over Productivity not Efficiency  

Bad writing is destroying your company’s productivity 

Your brain has a delete button; here’s how to use it 

The six step process to get your brain to focus 

How to cut your email time in half 

 

 

 

 

• New Task (works in OneNote too!)Ctrl + Shift + k

• New Mail MessageCtrl + Shift + m

• New AppointmentCtrl + Shift + a

• New ContactCtrl + Shift + c

• New NoteCtrl + Shift + n

• To save and close an Outlook itemAlt + s

• To hightlight all textCtrl + a

• Permanently deleteShift + Delete

https://hbr.org/2016/08/until-you-have-productivity-skills-productivity-tools-are-useless
https://hbr.org/2017/03/great-companies-obsess-over-productivity-not-efficiency
https://hbr.org/2016/09/bad-writing-is-destroying-your-companys-productivity
https://www.fastcompany.com/3059634/your-most-productive-self/your-brain-has-a-delete-button-heres-how-to-use-it
https://www.fastcompany.com/3066870/work-smart/the-6-step-process-to-train-your-brain-to-focus
https://www.fastcompany.com/3066716/how-to-cut-your-email-time-in-half
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Keeping Your EDGE Alive! 

Visit our Alumni Center for Continued Learning and Support 

 Six Follow-up Emails to Reinforce Learning 

 Live Refresher Webinars 

 Best Practices for mobile, OneNote & more 

 Outlook Upgrade Videos 

 Supplemental EDGE Tools 

 Access to Instructors 

 Digital Participant Workbook 

EffectiveEdge.com/Alumni 

Login: your email address 

Password: livetheedge 

 

 

 

Stay Connected! 

   

facebook.com 

/EffectiveEdge 

twitter.com 

/Effective_Edge 

linkedin.com/company 

/the-effective-edge 

Create a task to join our Alumni Group on Linkedin 

Go to Linkedin.com and search for Effective Edge Alumni 

Find additional Outlook tips and tricks, free webinars, prizes and more. 

 

file:///C:/Users/stacy.cross.EFFECTIVE/Desktop/EFP%20Update/EffectiveEdge.com/Alumni
file:///C:/Users/stacy.cross.EFFECTIVE/Desktop/EFP%20Update/EffectiveEdge.com/Alumni
https://www.linkedin.com/groups/1778260
https://www.linkedin.com/groups/1778260

